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About Formulator Tarsia 

Formulator Tarsia makes it easy to create your own mathematical learning activities. With 
this software you will easily be able to create, print out, save and exchange customised 
jigsaws, domino activities and a variety of rectangular card sort activities. The activities 
created using this software can be presented in printable form, ready to cut out. There are 
several types of activity:  

• hexagonal jigsaws made up of equilateral triangles; 

• different sets of rectangular cards with expressions; 

• dominoes for a domino activity.  



Products List of Formulator MathML Suite 
 

Hermitech Laboratory provides a range of different solutions based on the interactive 
mathematical expressions editor. This set of products is known as Formulator MathML 
Suite. 

Formulator MathML Suite comprises: 
 
� mathematical expressions editing (based on MathML 2.0 standard) 

o standalone editions 
Formulator MathML Weaver 
Formulator Express 

o component editions 
Formulator ActiveX Control 
Formulator Express ActiveX Control 

 
� plug-ins 

Formulator MathML IE Performer (plug-in for Internet Explorer) 
Formulator plug-in for Altova XMLSpy 

 
� support of mathematics learning activities 

Formulator Tarsia 
 
The following table is a brief comparison between products of Formulator MathML 

Suite. 
 

Product from the Formulator MathML Suite 
MathML 
Weaver 

Express 
ActiveX 
Control 

Express 
ActiveX 
Control 

MathML IE 
Performer 

plug-in for 
XMLSpy 

Tarsia 

General features 

availability $ free $ free free free free 

to run as a standalone application + +     + 

to develop a new software   + +    

plug-in (need third party software)     + +  

Basic editing features 

rendering of mathematical expressions + + + + + + + 

editing of mathematical expressions + + + +  + + 

font styles + + + + + + + 

font sizes + + + + + + + 

keyboard shortcuts + + + +  + + 

printing formulas +  +   + + 

Advanced editing features 

zoom + + + + + + + 

nested view + + + + + + + 

on-the-fly editing of MathML node properties +  +     

“MathML Tree” editing mode +  +     

hints on MathML tags, attributes and values +  +     

“MathML Text” editing mode +  +     

“XHTML” editing mode +  +     

building of jig-saw math puzzle by a template       + 

MathML support 

visual editing of Presentation Markup + + + +  + + 



 

Product from the Formulator MathML Suite 
MathML 
Weaver 

Express 
ActiveX 
Control 

Express 
ActiveX 
Control 

MathML IE 
Performer 

plug-in for 
XMLSpy 

Tarsia 

visual editing of Content Markup +  +     

visual editing of Mixed Markup +  +     

Product from the Formulator MathML Suite 
MathML 
Weaver 

Express 
ActiveX 
Control 

Express 
ActiveX 
Control 

MathML IE 
Performer 

plug-in for 
XMLSpy 

Tarsia 

Import/Export 

import from MathML text + + + + + + + 

import from MathML tree +  +     

export to MathML + + + + + + + 

export to raster images +  +     

export to vector images +  +    + 

publishing mathematics on web +  +     

inserting images into documents +  +    + 

integrating into Microsoft Word + + + +    

Developing a new software 

import from MathML text   +     

import from MathML tree   +     

export to MathML   + +    

export to raster images   +     

export to vector images   +     

manage the appearance of the control   +     

automate operations with the Clipboard   +     

automate styles   +     

automate sizes   +     

automate zoom feature   +     

automate nested view feature   +     

emulate user pressing a button   +     

 



Working with Formulator Tarsia 

Create a new activity 

To create a new activity 

Select 'New' on the 'File' menu or click on the ‘New’ icon on the Standard toolbar 

The 'New Document' dialog box appears with the list of available types of activities. The 
default activity type will be highlighted. 

 

 

• Select the type of activity you want to create from the list. 

• Click the OK button. 

The new activity of specified type will be opened in the working area.  

Note: The 'New Document' dialog box appears at startup, unless the ‘show this dialog on 
startup’ box is unchecked.  



Changing the default setting 

To change the default type of a new document, select the appropriate type from the drop-
down list 

 

 

Activity types and layouts 

Hexagonal Jigsaw 

 

The hexagonal jigsaw is made up of 24 equilateral triangles. 
Each edge of each triangle has a mathematical expression on it. 
Learners collaborate in groups, placing pieces with matched 
equivalent expressions in turn to form a hexagon. 

Using this software you can create two types of jigsaws:  

Standard Hexagonal Jigsaw 

The standard jigsaw does not have expressions around the 
outside edges. The edges provide learners with clues about how 
the jigsaw fits together. 

Extended Hexagonal Jigsaw 

The extended jigsaw has expressions on the outside edges. The 
extended jigsaw is more difficult as it is not obvious where the 
edges are. As an extension activity learners might be asked to 
write their own expressions to match the outside expressions. 
Further extension work can be produced by substituting some 



blank pieces into the activity. 

Simplified Versions 

There are also simplified versions of both of the above jigsaws. 
These are six piece jigsaws (with or without edge expressions) 
that can be used to produce a simple jigsaw or provide a more 
straightforward starting point for learners who might find a full 
jigsaw rather daunting. These can be accessed from the Right 
Hand menu options whenever the output or solution options 
are selected. 

 

Rectangular Cards 

 

This software allows you to create different sets of rectangular 
cards with expressions for various activities that involve 
comparing mathematical expressions and matching equivalent 
ones. You will find ideas for these activities in ‘Improving 
learning in mathematics’. 

 

A domino activity  

 

The dominoes can be created for a domino activity. Learners 
could begin with the 'Start' domino and then add dominoes so 
that the matching expressions are equivalent. Blank dominoes 
can be provided from learners to extend the activity by creating 
their own expressions. Replacing the START / FINISH pair with 
equivalent expressions will create an activity that forms a 
continuous loop. 



Formulator Tarsia interface  

The software contains the following menus, windows and toolbars:  

• (1) System menu; 

• (2) 'Formulator Expression' toolbar (appears only on the 'Input' view of activities);  

• (3) 'Standard' toolbar  

NB: (if the Formulator Expression toolbar is active, select Standard toolbar Tab)  

• (4) Bottom navigation bar;  

• (5) Right hand navigation bar (appears in the input view and in other views when 
there are several options); 

• (6) Document area;  

• (7) Status bar.  

It is possible to hide toolbars (2), (3) and Status bar (7) if necessary (e.g. to extend the 
viewing area). To show/hide toolbars and status bar use system menu (view) and click on 
them so that a tick appears/disappears. 

 

 

System Menu 

File menu 

• New (Ctrl+N)  

Opens a dialog box 'New'. This dialog box allows you to choose a new type of activity and 
then open an empty activity document by using the OK button. The new activity 



document will be untitled until you give it a name when you save it as a file using the 
'Save' or 'Save As...' commands on this menu. 

• Open (Ctrl+O)  

Opens an existing Tarsia file from the disk, and displays it in a new window. When you 
choose the 'Open' command, Tarsia displays the standard 'Open' dialog box, which lets 
you change drives and directories until you find the file you need, and then open it either 
by double-clicking or by using the OK button. If you worked on a Tarsia file recently, you 
may be able to open it more quickly by choosing its name from the bottom section of the 
'File' menu. 

• Close (Ctrl+F4)  

Closes the activity window. If you have made changes to the activity in this window, a 
dialog box will appear asking you if you want to save these changes. You can also close a 
window by clicking the 'Close' Box in the upper-right corner of the window. 

• Save (Ctrl+S)  

Saves the current version of the activity that you are working on. If your activity is 
untitled, a 'Save As' dialog box will appear so that you can choose a name for it. Once an 
activity has been named and saved on disk, using the 'Save' command again will replace 
the previous version with the new one. If you want to keep the previous version in 
addition to the new one, use the 'Save As...' command described below. 

• Save As  

Preserves the current version of the activity that you are working on by saving it on disk. 
Use the 'Save As...' command, rather than the Save command, whenever you want to save 
an untitled activity, or when you want to save an activity under a new name, in a different 
folder, or in a different file format. 

• Expression Library  

Opens the submenu that provides possibility to store activity expressions in the external 
libraries. Expression Library submenu contains items for creation expression library 
('New...' item), importing expressions from the expression library ('Import...' item) and 
exporting expressions to the expression library ('Export...' item). 

 

• Print (Ctrl+P)  

Prints the currently activity output, table of paired expressions or solution. (This item is 
available in the views that offer some printed output).  



• Page Setup...  

Sets up the printing parameters. 

• Properties…  

Opens the dialog for viewing and editing the documents properties: author, institution, 
comments.  

• (Most-recently-used files)  

Up to four Tarsia files that you recently worked on are listed at the bottom section of the 
'File' menu. You can re-open any of these files just by choosing its name from this menu. 
This is simply a convenient way to open a file, saving you the step of locating the file on 
disk. 

• Exit (Alt+F4)  

Terminates the Tarsia program. If you have made changes to activities in open Tarsia 
windows, you will be asked whether you want to save those changes. 

Edit menu 

• Undo (Ctrl+Z)  

Cancels the last command as shown in the text of the menu item. Every command can be 
undone, back to the point at which the window was opened. This item will be greyed out 
when there are no more commands to be reversed. 

• Redo (Ctrl+Y)  

Repeats the most recent Undo command. Every undone command can be restored. 

• Cut (Ctrl+X)  

Copies whatever is currently selected to the Clipboard, and deletes it from the expression. 
The expression is placed on the clipboard in two formats: binary and textual MathML 
format. Depending on the application that is accessing to this data, one of these copies will 
be used automatically. 

• Copy (Ctrl+C)  

Copies whatever is currently selected to the Clipboard. The expression is placed on the 
clipboard in two formats: binary and textual MathML format. Depending on the 
application that is accessing to this data, one of these copies will be used automatically. 

• Paste (Ctrl+V)  



Inserts the contents of the Clipboard into the expression at the insertion point, or replaces 
whatever is selected with the contents of the Clipboard. For this command to be 
successful, the Clipboard must contain a Tarsia Expression or a text. If the text does not 
meet requirements of the MathML format, it will be inserted literally. 

• Select All (Ctrl+A)  

Selects the entire expression, including portions that may be outside the bounds of the 
window. This command is useful for subsequently copying the equation to the Clipboard 
for transfer to a word processing document, or before using the 'Backspace' or 'Delete' 
keys to delete the entire contents of the equation window. 

• Insert Image…  

Inserts an image from the disk into the expression at the insertion point, or replaces 
whatever is selected with the image. When you choose the 'Insert Image' command, Tarsia 
displays the standard 'Open' dialog box, which lets you find the file you need, and then 
insert it either by double-clicking or by using the OK button. For this command to be 
successful, the Clipboard must contain an image of Windows Bitmap Format (*.bmp), 
Graphic Interchange Format (*.gif), JPEG File Interchange Format (*.jpg), Portable 
Network Graphics Format (*.png). 

View menu 

• Change Layout  

This command changes the layout mode of toolbars. There are two layouts avalable. The 
first is the normal docked toolbars layout. The second is tabbed toolbars layout. 

• Toolbars (Ctrl+Alt+B)  

Opens submenu with items that toggles the display of the Standard toolbar or Expression 
toolbars. A checkmarks next to this submenu items indicates that coresponding toolbars 
are currently displayed.  

• Tabbed Toolbar (Ctrl+Alt+B)  

This command toggles the display of the tabbed toolbar in the tabbed toolbar layout 
mode. 

• Status Bar  

This command toggles the display of the status bar. A checkmark next to this menu item 
indicates that the status bar is currently displayed. 

• Zoom  



This item displays the 'Zoom' menu which allows you to change the viewing scale. 

• Show Nesting (Ctrl+Shift+N)  

This command toggles the expression display between normal viewing mode and nesting 
mode where you can see the hierarchical structure of your expressions.  

• Show Read-Only (Ctrl+Shift+R)  

This command toggles the expression display between normal viewing mode and “show 
read-only nodes” mode where you can see highlighted that nodes which can't be changed. 

• Line Spacing…  

This command displays a dialog box that changes default value of distance between 
neighbour lines. 

Style menu 

• Math  

The Math style is the default style for typing mathematics. When the current style is 
'Math', Tarsia assigns styles to certain kinds of characters automatically, based on its 
knowledge of mathematics and typesetting conventions. For instance if Tarsia recognises a 
sequence of alphabetic characters as a standard operator (from MathML operator 
dictionary), it will use the Operator style. 

• Text (Ctrl+Shift+E)  

Use the 'Text' style when you want to type a plain text (e.g., in a natural language) instead 
of in math. 

• Function (Ctrl+Shift+F)  

Use this command to create a function name. 

• Variable (Ctrl+Shift+V)  

Use this command to assign the 'Variable' style to characters. 

• Greek (Ctrl+Shift+G)  

This command allows you to use the keyboard to type Greek letters. Once this style is 
active, the letters you type will be given the 'Greek' style. You can also enter a single Greek 
letter by using the Ctrl+G one-shot keyboard shortcut or by using the 'Greek symbol' 
palette. 



• Vector-Matrix (Ctrl+Shift+B)  

Mathematical vectors and matrices are given a bold character style. Use this command to 
assign the 'Vector-Matrix' style to selected text or subsequently typed characters. 

• Fixed (Ctrl+Shift+X)  

Use this command to assign the 'Fixed' (monospace) style to characters. 

• Operator (Ctrl+Shift+O)  

Use this command to assign the 'Operator' style to characters which are not recognized as 
a standard operator. 

• User 1 (Ctrl+Shift+U)  
• User 2 (Ctrl+Alt+Shift+U)  

The 'User 1' and 'User 2' styles may be used the way you like. Use the 'Define Styles' dialog 
to assign a font and character style to each. 

• Other...  

This command brings up the 'Other Style' dialog, allowing you to assign a font and 
character style and colour to selected text or subsequently typed characters. 

• Define...  

This command brings up the 'Define Styles' dialog, allowing you to change the font and 
character style and colour assigned to each style. 

Size menu 

• Large Symbol  

Use this command to assign the 'Large Symbol' type of font size to characters. 

• Regular  

Use this command to assign the 'Regular' type of font size to characters. 

• Subscript  

Use this command to assign the 'Subscript' type of font size to characters. 

• Sub-Subscript  

Use this command to assign the 'Sub-Subscript' type of font size to characters. 



• Other…  

This command brings up the 'Other Size' dialog, allowing you to assign a font size to 
selected text or subsequently typed characters. 

• Smaller (Alt+<)  

This command decreases a font size of selected text by 1 point. 

• Larger (Alt+>)  

This command increases a font size of selected text by 1 point. 

• Define…  

This command brings up the 'Define Size' dialog, allowing you to change default 
characters sizes (regular, subscripts, etc.). 

Options menu 

• Translate to MathML 2.0  

This item selects whether a namespace will be used while converting mathematical 
expression to MathML. 

• Indents…  

This item selects indents values for a document.  

Window menu 

• Previous Input (Alt+Shift+Up)  

Switches to the editing area for the expression on previous card or to previous expression 
of current card. 

• Next Input (Alt+Shift+Down)  

Switches to the editing area for the expression on next card or to next expression of current 
card. 

• Switch Input (Shift+Tab)  

Switches between editing areas for paired expressions. 

• Cascade  

Rearranges all open equation so they overlap in a cascade. 



• Tile  

Tiles all open equation windows vertically. 

• Arrange Icons  

Arranges the icons of the windows you have minimized, neatly at the bottom left of the 
window. 

• (open windows)  

The titles of all open activity windows are listed at the bottom of the Window menu. You 
can bring any of these windows to the front just by choosing its name from this menu. 

Help menu 

This menu contains commands that bring up Tarsia's online help, or find out about the 
Tarsia application (e.g. its version number). 

• Contents and Index (F1)  

This command displays the table of contents for Tarsia's online help. 

• Index  

This command displays the index for Tarsia's online help. 

• Tip of the Day  

This command opens the 'Tip of the Day' dialog. 

• About Tarsia...  

This command displays Tarsia’s About box showing you: 

o The version of the Tarsia application you are currently using;  
o Hermitech Laboratory contact information.  

 



Standard toolbar 

The 'Standard' toolbar contains buttons for common operations from Tarsia menus: 'New', 
'Open', 'Save', 'Cut', 'Copy', 'Paste', 'Undo', 'Redo', 'Insert Image', 'Zoom', 'Filter' and 
'About'. Use these buttons just as you would use the equivalent menu commands (see 
'System Menu' section for details).  

 

 

 

'New' and 'Zoom' buttons of the 'Standard' toolbar have drop-down lists that 
allow choosing options of the operations. 

 

'Filter' button provides switching between 'Normal' and 'Simplified' input 
modes of hexagonal jigsaw activities. Normal Input mode provides access to 
all the expressions of the jigsaw activity. 'Simplified Input' mode disables all 
the expressions that are not in the range of simplified version of jigsaw 
(internal part of hexagon). 

 

Formulator Expression Toolbars 

Formulator Ttarsia provides a template containing graphics and edit boxes for each basic 
mathematical construct. Users can insert a template into activity documents via expression 
toolbar. There are several battons on the toolbar containing palettes of homogeneous 
templates or symbols for fractions, radicals, sums, matrices, various types of brackets and 
braces, etc. 

 



Expression toolbar templates comprises:  

• relational and logical symbols  
• spaces templates  
• operator symbols  
• arrow symbols  
• set theory symbols  
• special constants  
• miscellaneous symbols  
• Greek characters (lowercase)  
• Greek characters (uppercase)  
• differentiation templates  
• fence templates  
• fraction and radical templates  
• subscript and superscript templates  
• summation templates  
• integral templates  
• underbar and overbar templates  
• labeled arrow templates  
• products and set theory templates  
• table templates  
• box templates  

 

Bottom navigation bar 

This navigation bar is located under the 'Document area' and allows you to switch 
between different views of an activity. The bar changes according to the type of activity 
selected. For instance, hexagonal jigsaws and dominoes have 4 types of views: 'Input', 
'Table', 'Output'. Solution. The rest of activities have the only 'Input' and 'Output' views. 

 

 



Right hand navigation bar 

This navigation bar is located to the right of 'Document area' 
and allows you to quickly jump to any of your expressions 
in order to edit them. The number of the expression you are 
currently working on is darkened. There are two types of 
navigation arrows: single arrows to move the bar one place 
forward or back, double arrows to move the bar by ten 
increments forward of back. 

 

 

Document area  

The document area is used for both entering the expressions in the editing slots and for 
viewing. Editing slots are used when building mathematical expressions for activities 
cards (for the 'Input' view). The viewing area is used for the other reasons (e.g. browsing, 
print preview etc.) ('Table', 'Output', 'Solution' views). When typing the mathematical 
expression the document area contains a slot or series of slots for expressions. To build 
mathematical expressions, please use the toolbar, and insert the chosen expression slot in 
the cursor position, type the text, numbers or operators. For 'Formulator Expression 
toolbar' the keyboard shortcuts are also available. 

 

Status bar  

This bar, at the bottom of the screen, reflects various kinds of status information about the 
Tarsia application. The status bar changes respectively to the change the view type, 
selected from the bottom navigation bar. Its content varies from the indication of 'Zoom' 
and 'NumLock' switched on/off up to indication of the style and size of the expression 
typed. 

 



Inputting the Expressions 

The software provides an easy-to-use mathematical expressions editing tool to create 
expressions that appear on the cards for activities. This tool is based on Hermitech 
Formulator 2.0 which allows you to create mathematical expressions through simple 
point-and-click techniques. It has an intuitive and visually oriented interface similar to the 
most text editors for Windows. Tarsia provides a large number of templates giving the 
possibility of constructing a wide range of mathematical expressions. 

Input of the expressions:  

1. Select Input page using the 'Input' button of the bottom navigation bar.  

 

2. Type the expressions using the keyboard and selecting the mathematical constructs 
from the toolbars.  

When working with expressions you can use variety of Tarsia features: management of the 
expressions' styles and sizes, zoom in to or zoom out of the expressions, nested view, 
export expressions in MathML format or into image. You can use standard elements of 
user interface like menus , toolbars , and shortcuts. 

Styles of expressions text  

Each character in a Tarsia expression can be directly assigned a specific font and character 
style or can be of one of eleven styles. Each style is defined as a combination of a font and 
character style. By changing the style of a text fragment, a user can quickly define its 
appearance and behaviour rules and by changing the definition of a style, a user can 
quickly change the appearance of all the characters that use it.  

The 11 styles available in Tarsia are 'Text', 'Variable', 'Function', 'Greek', 'Vector-Matrix', 
'Number', 'Fixed', 'Operator', 'Extra-Math', 'User 1', and 'User 2'. Tarsia assigns styles to 
certain kinds of characters automatically, based on its knowledge of mathematics and 
typesetting conventions. This intelligent assignment of styles is a useful feature of Tarsia 
which can significantly simplify your work. Assigning style 'Math' to a set of characters a 
user can explicitly define this intelligent behaviour to be a rule for these characters. 



Change the font size in an expression 

Tarsia provides default font sizes for each edit box in a mathematical expression. There are 
four reserved cases of changing font size:  

• regular text;  

• large symbols (like sums, products, integrals, etc.);  

• subscript/superscript text;  

• subscript/superscript nested in the subscript/superscript text (subscript/ 
superscript of the next level).  

You can allow Tarsia to select font size automatically or you can manually apply the size 
required using items if the 'Size' menu.  

If you think that text should be of particular size, there is an option to assign explicitly any 
font size between 5 and 127 points using the 'Other…' item of the 'Size' menu. Similarly, 
items 'Smaller' and 'Larger' allow you to change the current font size by 1 point.  

Default values of customised types of font size can be changed using dialog box 'Define 
size' (the 'Define…' item of the 'Size' menu). 

 

Zoom in or zoom out of the activity 

To maximize of minimize the size of the image on the screen, you can use 'zoom' from the 
'View' menu, item 'Zoom'. This feature allows you to get a magnified or reduced view of 
an activity by choosing from the list of zoom scales.  

1. To choose the zoom scale for the view, click the arrow next to the 'Zoom' box on the 
'Standard' toolbar.  

2. Select the zoom scale you want.  

 

Keyboard shortcuts 

Keyboard shortcuts activate some Tarsia operations by pressing the key combinations. 
Note that some shortcuts require you to type two keystroke combinations consecutively.  

Formatting 

Commands to format the equation elements: 

• Insert Tab (Tab);  
• New Line (Enter).  

Menu Commands 

Commands for items of File menu: 



• New (Ctrl+N);  
• Open (Ctrl+O);  
• Close (Ctrl+F4);  
• Save (Ctrl+S);  
• Print (Ctrl+P);  
• Exit (Alt+F4). 

Commands for items of Edit menu: 

• Undo (Ctrl+Z);  
• Redo (Ctrl+Y);  
• Cut (Ctrl+X);  
• Copy (Ctrl+C);  
• Paste (Ctrl+V);  
• Select All (Ctrl+A). 

Commands for items of View menu: 

• Zoom/100% (Ctrl+1);  
• Zoom/200% (Ctrl+2);  
• Zoom/300% (Ctrl+3);  
• Zoom/500% (Ctrl+5);  
• Zoom/1000% (Ctrl+0);  
• Show Nesting (Ctrl+Shift+N);  
• Toolbar (Ctrl+Alt+B);  
• Status Bar. 

Commands for items of Style menu: 

• Math (Ctrl+Shift+M);  
• Text (Ctrl+Shift+E);  
• Function (Ctrl+Shift+F);  
• Variable (Ctrl+Shift+V);  
• Greek (Ctrl+Shift+G);  
• Vector-Matrix (Ctrl+Shift+B);  
• Fixed (Ctrl+Shift+X);  
• Operator (Ctrl+Shift+O);  
• User 1 (Ctrl+Shift+U);  
• User 2 (Ctrl+Alt+Shift+U). 

Commands for items of Size menu: 

• Smaller (Alt+<);  
• Larger (Alt+>).  

Commands for items of Window menu:  



• Previous Input (Alt+Shift+Up);  
• Next Input (Alt+Shift+Down);  
• Switch Input (Shift+Tab);  

Commands for items of Help menu: 

• Contents and Index (F1). 

Navigation and Selection 

Commands for moving around and/or selecting items in the current expression: 

• Beginning of Slot (Home);  
• Delete Left (Backspace);  
• Delete Right (Delete);  
• End of Slot (End);  
• Move Down (Down);  
• Move Down Extend Selection (Shift+Down);  
• Move Left (Left);  
• Move Left Extend Selection (Shift+Left);  
• Move Right (Right);  
• Move Right Extend Selection (Shift+Right);  
• Move Up (Up);  
• Move Up Extend Selection (Shift+Up);  
• Scroll Up (Page Up);  
• Scroll Down (Page Down). 

Toolbar Commands 

Commands for items of Logics toolbar: 

• Less than or equal to (Ctrl+K,,);  
• Greater than or equal to (Ctrl+K,.);  
• Not equal to (Ctrl+K,+);  
• Identical to (Ctrl+K,=);  
• Tilde operator (Ctrl+K,Alt+~);  
• Almost equal to (Ctrl+K,~);  
• Proportional to (Ctrl+K,P);  
• Therefore (Ctrl+Shift+K,T);  
• There exists (Ctrl+Shift+K,E);  
• For all (Ctrl+Shift+K,A);  
• Not sign (Ctrl+Shift+K,N);  
• Logical and (Ctrl+Shift+K,7);  
• Logical or (Ctrl+Shift+K,\). 

Commands for items of Space toolbar: 



• 1-point space (Ctrl+Alt+Space);  
• Thin space (1/6 EM) (Ctrl+Space);  
• Thick space (1/3 EM) (Ctrl+Shift+Space);  
• EM space (Ctrl+K,4). 

Commands for items of Operator toolbar: 

• Plus-minus sign (Ctrl+Shift+K,=);  
• Multiplication sign (Ctrl+K,T);  
• Asterisk operator (Ctrl+Shift+K,*);  
• Division sign (Ctrl+Shift+K,/);  
• Dot operator (Ctrl+Shift+K,.);  
• Bullet (Ctrl+Shift+K,8);  
• Left-pointing angle bracket (Ctrl+Shift+K,<);  
• Right-pointing angle bracket (Ctrl+Shift+K,>). 

Commands for items of the Arrow toolbar: 

• Left right arrow (Ctrl+K,Alt+Left);  
• Rightwards arrow (Ctrl+K,Right);  
• Leftwards arrow (Ctrl+K,Left);  
• Up down arrow (Ctrl+K,Alt+Up);  
• Upwards arrow (Ctrl+K,Up);  
• Downwards arrow (Ctrl+K,Down);  
• Left right double arrow (Ctrl+K,Alt+Shift+Left);  
• Rightwards double arrow (Ctrl+K,Shift+Right);  
• Leftwards double arrow (Ctrl+K,Shift+Left);  
• Up down double arrow (Ctrl+K,Alt+Shift+Up);  
• Upwards double arrow (Ctrl+K,Shift+Up);  
• Downwards double arrow (Ctrl+K,Shift+Down);  
• Rightwards arrow from bar (Ctrl+K,Tab);  
• Downwards arrow with corner leftwards (Ctrl+K,Enter). 

Commands for items of Set toolbar: 

• Element of (Ctrl+K,E);  
• Not an element of (Ctrl+K,Shift+E);  
• Union (Ctrl+K,U);  
• Intersection (Ctrl+K,X);  
• Subset (Ctrl+K,C);  
• Superset (Ctrl+K,S);  
• Not a subset of (Ctrl+K,Shift+C);  
• Empty set (Ctrl+K,O). 

Commands for items of Const toolbar: 

• Partial differential (Ctrl+K,D);  



• Greek small letter pi (Ctrl+G,P);  
• Planck constant over two pi (Ctrl+K,H);  
• Infinity (Ctrl+K,I);  
• Latin small letter lambda with stroke (Ctrl+K,L);  
• Script small l (Ctrl+Shift+K,L). 

Commands for items of Misc toolbar: 

• Fraktur capital I, imaginary part (Ctrl+K,Shift-I);  
• Fraktur capital R, real part (Ctrl+K,Shift-R);  
• Alef symbol (Ctrl+K,A);  
• Blackboard-bold capital R, the set of all real numbers (Ctrl+D,Shift+R);  
• Blackboard-bold capital Z, the set of all integer numbers (Ctrl+D,Shift+Z);  
• Blackboard-bold capital C, the set of all rational numbers (Ctrl+D,Shift+C);  
• Blackboard-bold capital Q, the set of all rational numbers (Ctrl+D,Shift+Q);  
• Blackboard-bold capital N, the set of all natural numbers (Ctrl+D,Shift+N);  
• Greek capital letter delta (Ctrl+G,Shift+D);  
• Greek capital letter omega (Ctrl+G,Shift+W);  
• Inverted ohm sign (Ctrl+Shift+K,Shift+O);  
• Degree sign (Ctrl+Shift+K,D);  
• Angle (Ctrl+Shift+K,Shift+A);  
• Measured angle (Ctrl+Shift+K,Alt+A);  
• Spherical angle (Ctrl+Shift+K,Alt+Shift+A);  
• Perpendicular (Ctrl+Shift+K,P);  
• Parallel (Ctrl+Shift+K,I). 

Commands for items of Greek Lo toolbar: 

• Greek small letter alpha (Ctrl+G,A);  
• Greek small letter beta (Ctrl+G,B);  
• Greek small letter gamma (Ctrl+G,G);  
• Greek small letter delta (Ctrl+G,D);  
• Greek small letter epsilon (Ctrl+G,E);  
• Greek small letter zeta (Ctrl+G,Z);  
• Greek small letter eta (Ctrl+G,H);  
• Greek small letter theta (Ctrl+G,Q);  
• Greek small letter iota (Ctrl+G,I);  
• Greek small letter kappa (Ctrl+G,K);  
• Greek small letter lambda (Ctrl+G,L);  
• Greek small letter mu (Ctrl+G,M);  
• Greek small letter nu (Ctrl+G,N);  
• Greek small letter xi (Ctrl+G,X);  
• Greek small letter omicron (Ctrl+G,O);  
• Greek small letter pi (Ctrl+G,P);  
• Greek small letter rho (Ctrl+G,R);  
• Greek sigma symbol (Ctrl+G,Shift+V);  
• Greek small letter sigma (Ctrl+G,S);  



• Greek small letter tau (Ctrl+G,T);  
• Greek small letter upsilon (Ctrl+G,U);  
• Greek small letter phi (Ctrl+G,F);  
• Greek phi symbol (Ctrl+G,J);  
• Greek small letter chi (Ctrl+G,C);  
• Greek small letter psi (Ctrl+G,Y);  
• Greek small letter omega (Ctrl+G,W). 

Commands for items of Greek Up toolbar: 

• Greek capital letter alpha (Ctrl+G,Shift+A);  
• Greek capital letter beta (Ctrl+G,Shift+B);  
• Greek capital letter gamma (Ctrl+G,Shift+G);  
• Greek capital letter delta (Ctrl+G,Shift+D);  
• Greek capital letter epsilon (Ctrl+G,Shift+E);  
• Greek capital letter zeta (Ctrl+G,Shift+Z);  
• Greek capital letter eta (Ctrl+G,Shift+H);  
• Greek capital letter theta (Ctrl+G,Shift+Q);  
• Greek capital letter iota (Ctrl+G,Shift+I);  
• Greek capital letter kappa (Ctrl+G,Shift+K);  
• Greek capital letter lambda (Ctrl+G,Shift+L);  
• Greek capital letter mu (Ctrl+G,Shift+M);  
• Greek capital letter nu (Ctrl+G,Shift+N);  
• Greek capital letter xi (Ctrl+G,Shift+X);  
• Greek capital letter omicron (Ctrl+G,Shift+O);  
• Greek capital letter pi (Ctrl+G,Shift+P);  
• Greek capital letter rho (Ctrl+G,Shift+R);  
• Greek capital letter sigma (Ctrl+G,Shift+S);  
• Greek capital letter tau (Ctrl+G,Shift+T);  
• Greek capital letter phi (Ctrl+G,Shift+F);  
• Greek capital letter chi (Ctrl+G,Shift+C);  
• Greek capital letter psi (Ctrl+G,Shift+Y);  
• Greek capital letter omega (Ctrl+G,Shift+W). 

Commands for items of Derivative toolbar: 

• First derivative(Ctrl+Alt+');  
• Second derivative (Ctrl+"). 

Commands for items of Brackets toolbar: 

• Parenthesis or round-brackets (Ctrl+9);  
• Brackets or square-brackets (Ctrl+[);  
• Braces or curly-brackets (Ctrl+{);  
• Angle brackets (Ctrl+,);  
• Single vertical bars (Ctrl+T,|);  
• Left brackets (Ctrl+T,[);  



• Right brackets (Ctrl+T,]);  
• Left braces (Ctrl+T,{);  
• Right braces (Ctrl+T,});  
• Left angle brackets (Ctrl+T,<);  
• Right angle brackets (Ctrl+T,>). 

Commands for items of Fraction and roots toolbar: 

• Full-size fraction (Ctrl+F);  
• Full-size diagonal fraction (Ctrl+/);  
• Slash fraction (Ctrl+T, Alt+/);  
• Square root (Ctrl+R);  
• nth root (Ctrl+T,N). 

Commands for items of Script toolbar: 

• Superscript (Ctrl+H);  
• Subscript (Ctrl+L);  
• Superscript and subscript (Ctrl+J);  
• Over-script (Ctrl+T, Shift+L);  
• Under-script (limit) (Ctrl+T, Alt-L);  
• Over-script and under-script (Ctrl+T, L). 

Commands for items of Sum toolbar: 

• Summation with no limits (Ctrl+T,Shift+S);  
• Summation with underscript limit (Ctrl+T,Alt+S);  
• Summation with underscript and overscript (Ctrl+T,S). 

Commands for items of Integral toolbar: 

• Indefinite integral (no limits) (Ctrl+Shift+I,!);  
• Definite integral with underscript and overscript limits (Ctrl+Shift+I,S);  
• Definite integral with subscript and superscript limit (Ctrl+I);  
• Definite integral with underscript limit (Ctrl+Shift+I,Alt+S);  
• Definite integral with subscript limit (Ctrl+Shift+I,Alt+1);  
• Double integral with no limits (Ctrl+Shift+I,@);  
• Double integral with underscript limit (Ctrl+Shift+I,2);  
• Double integral with subscript limit (Ctrl+Shift+I,Alt+2);  
• Triple integral with no limits (Ctrl+Shift+I,#);  
• Triple integral with underscript limit (Ctrl+Shift+I,3);  
• Triple integral with subscript limit (Ctrl+Shift+I,Alt+3);  
• Contour integral with no limits (Ctrl+Shift+I,Shift+C);  
• Contour integral with underscript limit (Ctrl+Shift+I,C);  
• Contour integral with subscript limit (Ctrl+Shift+I,Alt+C);  
• Area integral with no limits (Ctrl+Shift+I,Shift+A);  
• Area integral with underscript limit (Ctrl+Shift+I,A);  



• Area integral with subscript limit (Ctrl+Shift+I,Alt+A);  
• Volume integral with no limits (Ctrl+Shift+I,Shift+V);  
• Volume integral with underscript limit (Ctrl+Shift+I,V);  
• Volume integral with subscript limit (Ctrl+Shift+I,Alt+V);  
• Integral with counter-clockwise loop with no limits (Ctrl+Shift+I,Shift+Left);  
• Integral with counter-clockwise loop with underscript limit (Ctrl+Shift+I,Left);  
• Integral with counter-clockwise loop with subscript limit (Ctrl+Shift+I,Alt+Left);  
• Integral with clockwise loop with no limits (Ctrl+Shift+I,Shift+Right);  
• Integral with clockwise loop with underscript limit (Ctrl+Shift+I,Right);  
• Integral with clockwise loop with subscript limit (Ctrl+Shift+I,Alt+Right). 

Commands for items of Bars toolbar: 

• Tilde (Ctrl+^,~);  
• Hat (Ctrl+^,6);  
• Arc (Ctrl+^,9);  
• Joint status (Ctrl+^,J);  
• Over-bar (Ctrl+^,-);  
• Double over-bar (Ctrl+^,D);  
• Under-bar (Ctrl+^,_);  
• Double Under-bar (Ctrl+^,Shift+D);  
• Right arrow over-bar (Ctrl+^,Right);  
• Left arrow over-bar (Ctrl+^,Left);  
• Right harpoon over-bar (Ctrl+^,Alt+Right);  
• Double-headed arrow over-bar (Ctrl+^,Up);  
• Right arrow under-bar (Ctrl+^,Shift+Right);  
• Left arrow under-bar (Ctrl+^,Shift+Left);  
• Right harpoon under-bar (Ctrl+^,Alt+Shift+Right);  
• Double-headed arrow under-bar (Ctrl+^,Shift+Up);  
• Mid-line strike through (Ctrl+^,Alt+-);  
• Strike through (Ctrl+^,X);  
• Strike-through (bottom-left to upper-right) (Ctrl+^,/);  
• Strike-through (top-left to bottom-right) (Ctrl+^,\). 

Commands for items of Labels toolbar: 

• Right arrow with upper text slot (Ctrl+T,Shift+Right);  
• Right arrow with lower text slot (Ctrl+T,Alt+Right);  
• Right arrow with upper and lower text slot (Ctrl+T,Right);  
• Left arrow with upper text slot (Ctrl+T,Shift+Left);  
• Left arrow with lower text slot (Ctrl+T,Alt+Left);  
• Left arrow with upper and lower text slot (Ctrl+T,Left);  
• Double-headed arrow with upper text slot (Ctrl+T,Shift+Up);  
• Double-headed arrow with lower text slot (Ctrl+T,Alt+Up);  
• Double-headed arrow with upper and lower text slot (Ctrl+T,Up). 

Commands for items of Products toolbar: 



• Product with no limits (Ctrl+T,Shift+P);  
• Product with underscript limit (Ctrl+T,Alt+P);  
• Product with underscript and overscript limits (Ctrl+T,P);  
• Coproduct with no limits (Ctrl+T,Shift+C);  
• Coproduct with underscript limit (Ctrl+T,Alt+C);  
• Coproduct with underscript and overscript limits (Ctrl+T,C);  
• Intersection with no limits (Ctrl+T,Shift+I);  
• Intersection with underscript limit (Ctrl+T,Alt+I);  
• Intersection with underscript and overscript limits (Ctrl+T,I);  
• Union with no limits (Ctrl+T,Shift+U);  
• Union with underscript limit (Ctrl+T,Alt+U);  
• Union with underscript and overscript limits (Ctrl+T,U). 

Commands for items of Box toolbar: 

• Box (Ctrl+Shift+T,X).  



Checking using the table of expressions 

When you create a hexagonal jigsaw or domino activity it is useful to check the 
expressions by viewing the pairs of equivalent expressions in a table. The 'Table' page 
makes it possible to browse and print the expressions presented in matching pairs in table 
format.  

To open the 'Table' view page select the button 'Table' at the bottom navigation bar. 

 

To print the table of paired expressions click the 'Print' button on the Standard toolbar or 
select 'Print...' from the 'File' menu.  



Viewing the Output  

Formulator Tarsia allows you to preview an activity as it will appear when printed ready 
for cutting out. 'Output' view allows you to display the current activity, and to use ‘Zoom’ 
to change the size of the view. For hexagonal jigsaws, the level of magnification of the 
print out is controlled by the right-hand navigation bar using the ‘Normal size’, ‘Large 
size(8x3)’ and ‘Large size(24x1). The ‘Large size’ buttons allow you to produce a large 
puzzle which might be helpful to learners with visual impairments. The 'Simplified 
version' of the hexagonal activity output gives only the central six triangles of the jigsaw. 
Teachers and trainers can offer the simplified version of a jigsaw to learners who are 
finding the topic difficult and might benefit from a more limited choice of options. 
However, once learners have created the jigsaw, the teacher or trainer could then release 
the remaining triangles to complete the 24-triangle jigsaw.  

The right hand navigation bar appears only in jigsaw activities, the other types of activity 
have only the Normal size set by default. The Normal output can always be enlarged if 
required on a photocopier. 

To switch to output preview select the button 'Output' in the navigation bar at the bottom 
of the window.  

 



Viewing the Solution 

This view appears only in jigsaw and domino activities. These are not intended for use by 
learners but, while creating the activity you can see the solution of the activity presented 
on the 'Solution' view. This view makes it possible for you to display, browse and print 
out the current activity solution. The level of magnification of the view is controlled by the 
right hand navigation bar with buttons: 'Full version', shows the 24 piece jigsaw activity 
solution. 'Simplified version' displays the central six triangles only. To switch to solution 
preview select the button 'Solution' in the navigation bar at the bottom of the window. 

 



Page setup and printing  

Formulator Tarsia allows you to choose from many preset page sizes ranging from legal-
size paper and envelopes to the maximum page size the installed print-driver supports.  

The orientation of the page can be landscape or portrait. With landscape orientation the 
printout document width is greater than its height, and with portrait orientation the 
printout document height is greater than its width. Any pages you add to an activity 
project assume the current orientation. The options you choose when specifying the page 
layout can be used as a default for all new drawings you create. You can also adjust the 
page size and orientation settings to match the standard paper settings for printing.  

The margins box is for setting the page margin measurements. It is in inches or millimetres 
depending on the settings on your computer. If you want to change the units for setting 
margins, you must change the 'Regional Settings' in 'Control Panel'. 

Formulator Tarsia lets you print the active document by clicking 'Print' on the 'Standard' 
toolbar, creating one or more copies of the same jigsaw activity view (except the Input 
view, where this function is disabled). It is possible to specify which pages of the current 
view to print, for example – the page range. Printing into the file is also available. Printing 
a view into a file instead of to printer saves the document in a format that a different 
printer can use. For example, if you want to have your document printed by a commercial 
printing service that uses higher-resolution printers, you can print the document to a file, 
and then take that file to the commercial printer.  

Note: When printing to a file, it is necessary to determine first which printer — for 
example, a PostScript printer — will ultimately print the file. To do this, on the 'File' menu, 
click 'Print'. In the 'Name' box, click the printer you will use to print the file. Select the 
'Print' to file check box, and then click OK. In the 'File' name box in the 'Print' to file dialog 
box, type a file name.  

To print multiple copies: On the 'File' menu, click 'Print'. In the 'Number of copies' box, 
enter the number of copies you want to print.  



Saving activity document  

When you create a new activity, you need to save it for later use.  

To save an activity select 'Save' from the 'File' menu or click 'Save' on the 'Standard' 
toolbar. 

If the activity is new then the 'Save As' dialog box appears. Using this dialog box navigate 
to the folder where you intend to save the activity. In the 'File Name' text box, type a name 
for the activity. To confirm saving click the 'Save' button of the dialog box.  

If the activity was previously saved, the command 'Save' replaces the copy on disk with 
whatever is in the 'Input' window.  

To save the activity without replacing the old copy select 'Save As' from the 'File' menu. 
Save the worksheet under a different name. 

  

 


